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Foreword 

Please read the User Manual carefully before using this product. The User Manual which 

describes the operating procedures should be followed strictly. This manual detailed introduce 

the steps must be noted when using the product, operation which may result in abnormal, the risk 

may cause personal injury and product damage and other contents, refer to the chapters for details. 

Any anomalies or personal injury and device damage arising from use, maintain, store do not follow 

requirements of the User Manual, Our company is not responsible for the safety, reliability and 

performance guarantees! The manufacturer’s warranty service does not cover such faults! 

Our company has a factory record and user profile for each device, users enjoy free maintenance 

services for one year from the date of purchase. In order to facilitate us to provide you with a 

comprehensive and efficient maintenance service, please be sure to return the warranty card when 

you need repair service. 

Note: Please read the User Manual carefully before using this product. 

Described in this User Manual is in accordance with practical situation of the product. In case of 

modifications and software upgrades, the information contained in this document is subject to 

change without notice. 
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The warning items 

Before using this product, you should consider the safety and efficacy of the following 

described: 

◼ Described each measurement results combined with clinical symptoms by qualified doctors. 

◼ The reliability and operation of using this product whether meets the operation of this manual 

relate to the maintenance instructions. 

◼ The intended operator of this product may be the patient. 

◼ Do not perform maintenance and service while the device is in use. 

Responsibility of operator 

◼ The operator must carefully read the User Manual before use this product, and strictly follow 

the operating procedure of the User Manual. 

◼ Fully consider the security requirements during product design, but the operator should not 

ignore the observation for the patient and the state of machine. 

◼ The operator has the responsibility to provide the use condition of the product to our 

company. 
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Responsibility for our company 

◼ Our company have the responsibility to provide qualified product which conform to company 

standard of this product. 

◼ Our company will provide the circuit diagram, calibration method and other information at 

the request of the user to help the appropriate and qualified technicians to repair those parts 

designated by our company. 

◼ Our company have the responsibility to complete product maintenance according to the 

contract. 

◼ Our company have the responsibility to respond the requirements of user in time. 

◼ In the following case, our company is responsible for the impact on the safety, reliability and 

performance of the device: 

Assembly, addition, debugging, modification or repair are carried out by personnel approved 

by our company. 

The electrical facilities in the room are in compliance with the relevant requirements and the 

device is used in accordance with the User Manual. 

The User Manual is written by our company. All rights reserved. 

app:ds:company
app:ds:standard
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Chapter1  Introduction 

Operators do not need professional training, but should use this product after fully understanding the 

requirements in this manual. 

To prevent users from suffering hurt or damnification due to improper use,please refer to "Safety 

Precautions" and use this product properly. 

For an overall introduction to the Blood Pressure Monitor, please refer to General Information. 

For basic operating instructions, please refer to Button Function. 

For allocation of interface sockets, please refer to Interfaces. 

1.1  Safety Precautions 

 Warning    

◼ If not use correctly,it exists the possibility of damage for personnel and goods. 

◼ Good damage means the damage of house, property,domestic animal and pet. 

◼ For patients with server blood circulation disorder or common arrhythmias (such as 

atrial premature beats, ventricular premature beats, and atrial fibrillation), please use the 

device under the guidance of a doctor. Otherwise it may lead to acute hemorrhage, or 

measurement error as a result of squeezed arm. 

◼ You must not perform NIBP measurements on patients with sickle-cell disease or under 
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any condition which the skin is damaged or expected to be damaged. 

◼ For a thrombasthemia patient, it is important to determine whether measurement of the 

blood pressure shall be done automatically. The determination should be based on the clinical 

evaluation.  

◼  This device is only suitable for blood pressure monitoring of adults, not for pediatric 

and neonate use, otherwise it may cause harm to human body. 

 Warning  

⚫ Do not modify this device without authorization of the manufacturer. 

 Contraindication  
No contraindications. 

 Warning  
Do not use the device in the case of there are flammable anesthetic gasses mixing with the air 

or nitrous oxide. 

Otherwise it may cause risk. 

For the person who can't express oneself, please use the device under the guidance of a doctor. 

Otherwise it may cause accident or dissension. 

Self-diagnosis and treatment using measured results may be dangerous. Follow the 
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instructions of your physician. 

Please hand measurement results to the doctor who knows your health and accept diagnosis. 

Please do not use for any other purpose except BP measurement. 

Otherwise it may cause accident or holdback 

Please use special cuff. 

Otherwise it is possible that measurement result is incorrect. 

Please do not keep the cuff in the over-inflated state for a long time. 

Otherwise it may cause risk. 

If liquid splashes on the device or accessories, especially when liquids may enter the pipe or 

device, stop using and contact the service department. 

Otherwise it may cause risk. 

Dispose of the packaging material, observing the applicable waste control regulations and 

keeping it out of children's reach. 

Otherwise it may cause harm to the environment or children. 

Please use approved accessories for the device and check that the device and accessories are 

working properly and safely before use. 

Otherwise the measurement result may be inaccurate or an accident may occur. 

When the device is accidentally damp, it should be placed in a dry and ventilated place for a 
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period of time to dissipate moisture. 

Otherwise the device may be damaged due to moisture. 

Do not store and transport the device outside the specified environment. 

Otherwise it may cause measurement error. 

It is recommended that you check if there is any damage on the device or the accessories 

regularly, if you find any damage, stop using it, and contact the biomedical engineer of the 

hospital or our Customer Service immediately. Do not disassemble, repair and modify the 

device without permission. 

Otherwise it cannot be accurately measured. 

This device can not be used on mobile transport platforms. 

Otherwise it may cause measurement error. 

This device can not be used on a tilted tabletop. 

Otherwise there is a risk of falling. 

Dispose of packaging materials, waste batteries and end-of-life products in accordance with 

local laws and regulations. The end-of-life products and materials are properly disposed of by 

the user in accordance with the authority’s decree. 

Replace accessories which not provided by our company may lead to the occurrence of errors. 

Without our company or other approved maintenance organizations trained service personnel should 
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not try to maintain the product. 

This device can only be used for one test object at a time. 

If the small parts on the device are inhaled or swallowed, please consult a doctor promptly. 

The device and accessories are processed with allergenic materials. If you are allergic to it , stop 

using this product. 

Do not use a mobile phone near the blood pressure monitor. Excessive radiation fields 

generated by mobile phones can interfere with the normal use of the blood pressure monitor. 

The blood pressure monitor has slight electromagnetic radiation to the external environment, 

but does not affect the normal use of other equipment. 

This device is suitable for occasions with electrosurgical equipment, but when used with 

electrosurgical equipment, patient safety must be given the highest priority. 

The parts of the device that are in contact with the patient (cuffs, air pipes, enclosue, etc.) are 

made of insulating material and the device is protected against electric shock. When high 

frequency or defibrillation devices are applied to the patient, no special precautions need to be 

taken and the defibrillator discharge will not affect the device. 

If Luer lock connectors are used in the construction of tubing, there is a possibility that they might 

be inadvertently connected to intravascular fluid systems, allowing air to be pumped into a blood 

vessel. 
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This device is suitable for occasions with electrosurgical equipment, but when used with 

electrosurgical equipment, patient safety must be given the highest priority. 

When the monitor is wetted, please stop using it and contact us. 

After pressing the power button, if the device has display fault such as white screen, blurred 

screen or no display content, please contact our company. 

Do not place the device at a location that is difficult to operate the disconnecting device when 

charging. 

 Note  

◼ The software was developed in accordance with IEC60601-1. The possibility of hazards 

arising from errors in the software program has been minimized. 

◼ All analog and digital equipment connected to this device must be certified to IEC 

standards(such as IEC60950: Information technology equipment-Safety and IEC60601-1: 

Medical electrical equipment-Safety), and all equipment should be connected to in accordance 

with the requirement of the valid version of the IEC60601-1-1 system standard. The person 

connecting the additional equipment to the signal input and output port is responsible for 

whether the system complies with the IEC60601-1 standard. 

◼ Refer to the following chapters for the minimum value of patient physiological signals. 

Operation of the device below the minimum value may result in inaccurate results. 
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◼ The Monitor shall comply with the standard IEC 80601-2-30:Particular requirements 

for basic safety and essential performance of automated non-invasive sphygmomanometers. 

1.2  General Information 

Name：Ambulatory Blood Pressure Monitor 

Specification：ABPM70 

Structure: host, lithium battery, USB cable and upper device software 

Application: non-invasive continuous blood pressure monitoring 

The parts (cuff, enclosure, etc.) of the device in contact with the patient are made of insulating 

materials, and the device is protected against electric shock. When a defibrillation device is used on 

the patient, no special precautions need to be taken and the defibrillator discharging does not affect 

the device. 

The device is suitable for non-invasive continuous blood pressure monitoring in adults 

(including pregnant women), and can store up to 500 groups of data. Each record includes detailed 

measurement time, systolic blood pressure, diastolic blood pressure, error information and record 

number. 

It has friendly operation interfaces, adopts 1.3-inch color LCD screen, and has complete data 

review functions, including data review, data list, the current time, power, start measuring 

countdown, over-limit prompt and other information. 
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Users can perform many operations via the three buttons on the front panel, such as startup, 

manual measurement, language setting, and parameter changing (see the Button Functions section 

for details). 

When the battery is low, the buzzer will intermittently sound and the red light will flicker to 

remind users to charge the device. When the measurement data exceeds the set limit, the font color 

of the measurement result will turn red and the sound prompt will be generated. The user can turn 

the sound prompt on or off as required. 

The USB interface is located at the bottom of the device, which can be used to charge the lithium 

battery and upload data to the computer for further operations. 

 

 Figure 1.4.2 Bottom 
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 Caution  

The backlight will be off if the device is not operated for a period of time. After the backlight is 

off, the green light flickers intermittently to indicate that the device is monitoring the 

ambulatory blood pressure. 

 Caution  

The earliest records will be overwritten after the memory overflow. An icon indicating that the 

memory is full is displayed on the upper left of the main interface. 

1.3 Button Functions 

Operations can be completed by pressing buttons on the device. It has the following buttons: 

⚫  

In the shutdown state, long press the button to turn on the device. The red light and green light 

will flicker every time when turning on the device, indicating that the device is started successfully. 

Long press the button two times to turn off the device. In the menu and memory interfaces, short 

press it to return to the main interface, long press to make a selection. In the main interface, it is the 

measurement key, and short pressing it can start or stop the measurement. 
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⚫  

The text in the corresponding position on the screen (the bottom left position of the screen) 

indicates the function of this button. 

For example: In the main interface, it is used as the review button to review the data of the 

current user; In the menu interface, it is used as an up button. 

⚫  

The text in the corresponding position on the screen (the bottom right position of the screen) 

indicates the function of this button. 

For example: In the main interface, it is used as the menu button; In the menu interface, it is used as 

an up button.  

 Note  

⚫ After connecting the USB cable, all of the buttons are disabled. If the BP measurement 

is in progress, this measurement is will be automatically canceled. 

 Caution  

The two buttons  and  are disabled during measuring. 
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The rectangular symbol on the screen that moves with the pressing of   and  buttons is 

the cursor. Anywhere the cursor can rest is available for operation. If the cursor is not selected, the 

font is white and turns blue if the cursor is selected. 

1.4  Interfaces 

Different interfaces and sockets are located at different positions of the device for operation 

convenience. 

The NIBP cuff socket is located at the rear of the device. 

 Note  

The connection of the NIBP external air pipe is as shown: 
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图 1.4.1 External airway tube 

1.5  Accessories 

1) A cuff for adult 

2) An USB data line 

3) Software 

4) A lithium battery 

 Note  

The width of the cuff should be 40% of the limb circumference or 2/3 of the length of the 

upper arm.The length of the inflated part of the cuff should be sufficient to surround 50% to 
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80% of the limb. Unsuitable cuffs can produce erroneous readings. If there is a problem with 

the size of the cuff, use a larger cuff to reduce the error. 

Reusable Cuff of adult 

Patient type Limb circumference Width of the cuff 

Adult  22～35 cm 14 cm 

 Warning  

Please use the special accessories supplied by the manufacturer or replace the accessories 

according to the requirements of the manufacturer in order to avoid making harms to patients.  

 Note  

◼ The cuff is a consumable. In order to correctly measure blood pressure, please replace the cuff 

in time. 

◼ If the cuff leaks, please contact our company to buy a new one. 

 Note  

When the product and accessories described in this manual are about to exceed the period of use, 

they must be disposed according to relevant product handling specification. If you want to know 

more information, please contact our company or representative organization. 
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Chapter2  Getting Started 

2.1  Open the Package and Check 

Open the package and take out the device and accessories carefully. Keep the package for possible 

future transportation or storage. 

⚫ Check for any mechanical damage 

⚫ Check all accessories 

If there is any problem, contact our sales department or agent immediately. 

2.2  Battery replacement 

The device is power supplied by the lithium battery. Before replacing, remove the cuff from the 

host, and open the battery compartment cover to replace the battery. The operation steps are: 

         

①                   ②                ③              ④ 
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① Remove the cuff according to above figure 

② Follow the direction of the arrow to remove the battery cover, and install the battery 

according to the  polarities. 

③ Close the battery cover. 

④ Install the cuff back. 

 

Icon “ ”: It means that the battery is low, and the device makes sound prompt intermittently, 

please charge it by connecting with a USB cable or replace the battery. If the measurement is taken 

under low battery conditions, the measured data may be inaccurate. 

 Warning  

The battery should not be replaced by inadequately trained personnel, incorrect replacement 

operations (such as reversed installation, the wrong type of battery installed) may result in dangers 

of overheating, fire, or explosion. 

 Cautions  

◼ If the battery is unable to meet the working requirements, the device will make the low 

battery prompt, and will automatically turn off if the battery power decreases continuously. Please 
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turn off the device or take out the battery if you are not going to use the device for a long time. 

◼ Dispose of the exhausted batteries according to applicable local regulations about 

environmental.Otherwise it will cause environmental pollution. 

◼ The monitor is internally powered equipment, can be connected to the public grid. 

2.3  Power on the Instrument 

After pressing the power button , the indicator light flickers once, which means it is 

successfully turned on. Release the button, the system enters the main interface. 

In turning on state, long press the power button, it prompts “Press again”, and long press the power 

button one more time, it prompts “Thanks”, which means that the device is turned off. 

 Warning   

If any sign of damage is detected, or the instrument displays some error messages, do not use it 

on any patient. Contact biomedical engineer in the hospital or our Customer Service Center 

immediately.  

 Note  

Check all the functions that possibly be used and make sure that the device is in good status. 
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Chapter3  Display and Buttons 

3.1  Main Interface 

After pressing the power button , the indicator light flickers once, which means it is 

successfully turned on. Release the button, the system enters the main interface. 

The screen goes off after 15s without button operations, and the device enters the standby mode; 

the standby indicator light flickers every 8s, prompting that the device is working. 

When battery is low, the battery level of the battery icon is empty, and a prompt message is 

generated at the same time and the red light flickers regularly. 

The prompt sound switch is set in the menu, and a loudspeaker icon is displayed in the upper 

left corner of the screen to indicate that the prompt sound is on.  

The main interface shows the current measurement results, and the current time is displayed in the 

top middle of the screen. 

3.2  Measuring Interface 

Measuring interface displays real-time cuff pressure and the current measurement information. In 

the meurement process, except the  , other buttons are disabled. 
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 Note  

In any interface except the measurement, press  key to exit current interface and back to 

the boot-strap interface. 

3.3  Measure Result Interface 

The measure result includes: 

SYS: systolic blood pressure (mmHg/kPa) 

DIA: diastolic blood pressure (mmHg/kPa) 

PR: pulse rate (bpm) 

If there is an error during the measurement, an error message text will appear on the screen. If the 

PROMPT SOUND is set to be on, the sound would occur. Press the SILENCE key to stop the sound 

and press it once more to continue（See Section 4.4 for the explanation of error codes）. 

3.4   Menu interface 

In the main interface, follow the text prompt located at the bottom right corner of the screen to press 

the  button to enter the memory interface, and press the  to enter the menu; then press 

 and  buttons to make selections. 
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图 3.4.1 菜单 

After entering the menu interface, the menu includes: 

“Language”: Chinese, English 

“Unit”: mmHg, kPa 

“Sound”: ON, OFF 

 Note  

“Sound”: If it is set to “ON”, the buzzer is turned on and makes corresponding prompts, and the 

icon  is displayed in the main interface; if it is set to “OFF”, the buzzer is turned off and the 
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main interface does not display the icon . 

3.5  Memory interface 

In the main interface, press  button to enter the memory interface to review data. 

Data review interface: this interface displays the serial number and storage time of the current record, 

the systolic blood pressure and diastolic blood pressure. 
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Chapter4  NIBP Measuring 

4.1   Overview 

◼ The NIBP measurement adopts Oscillometric method. 

◼ Measurement mode: manual/auto mode. The measured value of SYS, MAP, DIA and PR can be 

displayed in every mode. 

◼ In "Manual" mode, the device only takes the measurement once. 

◼ In "Auto" mode, the device takes the measurement circularly. Time interval can be set as 

5/10/15/20/30/40/60/90/120/180/240 min. 

 Caution  

◼ Do not speak or move when measuring, and avoid any muscle movements. 

◼ Do not use any mobile devices, such as a mobile phone, near the device during measurement. 

◼ The position of the cuff will cause changes in the measurement results. 

◼ Do not touch the monitor, cuff and extension tube during the measurement. 

◼ For information on contraindications for NIBP measurements, refer to section 1.1 Safety 

Precautions. 

◼ The device has dual over-pressure protection function in both hardware and software, if the 

airbag is over inflated, the device will reset and deflate immediately. If the over inflation lasts long, 
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immediately disconnect the cuff from the device and cut off the power. 

◼ Use this device in an environment where temperature and humidity are appropriate, as this 

may cause measurement error. 

If the measurement interval is short, please pay close attention to the battery power, and replace the 

battery in time when the device alarms for low battery, otherwise the 24-hour ambulatory blood 

pressure monitoring may not be achieved. 

4.2  NIBP monitoring 

 Warning  

Do not apply the cuff to a limb that has an intravenous infusion or catheter. This could cause 

tissue injury around the catheter when infusion is slowed or blocked during cuff inflation. 

The effect of  blood flow interference and  resulting  harmful injury to the patient caused by 

contious cuff prssure due to connection tubing kinking; 

Due to blood flow interference, too frequent measurements can caue injury to the patient. 

Need to check by observation of the limb concerned that operation of the Automated 

sphygmomanometer does not result in prolonged impairment of the circulation of the blood of the 

patient; 

The minimum value of the patient's physiological signal is the lowest limit that the device could 
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measure. The measured result may inaccurate if the device running below the minimum amplitude 

or minimum value of patient's physiological signal. 

Do not twist or tangle the airway tube, otherwise it will cause continuous pressure in the cuff, then 

causing blocked blood flow and serious injury to the patient. 

Do not use the cuff on the injured area, otherwise it will cause more serious damage to the injured 

area. 

Do not use the cuff on the site where intravascular treatment is being performed or with catheter 

connection, otherwise it may cause temporary blockage of blood flow and then cause injury to the 

patient. 

Do not use the cuff on the side of the mastectomy or  lymph node clearance; 

The pressure by cuff may cause temporary weakness of some functions of the body. So do not use 

monitoring medical electrical equipment on corresponding arm. 

Do not move during measuring, or the blood flow of patient may slow down. 

The device needs 2 hours to recover from the lowest storage temperature to reach its performance of 

intended use. 

The device needs 4 hours to recover from the highest storage temperature to reach its performance 

of intended use. 

1. Turn on the device. 
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2. Follow the method described below to apply the host to the patient’s upper arm. (Figure4.2.1). 

⚫ Ensure the cuff is completely deflated. 

⚫ Apply the appropriate size cuff to the patient, and make sure that the symbol "φ" is over the 

appropriate artery. Ensure that the cuff is not wrapped too tightly around the limb. Excessive 

tightness may cause discoloration and eventual ischemia of the extremities. 

 

Figure 4.2.1 Cuff applying 

3.Connect the cuff to the airway tube. The cuff should be placed at the same level as the patient's 

heart. Otherwise amend the measurement results by the following methods 

⚫ If the cuff is placed higher than the heart level, add 0.75 mmHg (0.10 kPa) for each inch of 

difference. 

⚫ If it is placed lower than the heart level, minus 0.75 mmHg (0.10 kPa) for each inch of 

difference. 
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4.Measurement Way: 

Measurement in quiet and relaxing state. 

⚫ Adopt a comfortable sitting position, use back and arms to support the body. 

⚫ Place your elbow on a table, the palm faces up and the body is relaxed. 

⚫ The cuff is level with your heart. 

⚫ Feet flat on the floor, and do not cross your legs. 

⚫ Press     button on the front panel to start inflating and measuring. 

 Advice   

The high and low location of cuff will cause changes in measure results. 

Do not touch the sphygmomanometer, cuff and windpipe during measure.   

Measurements should be taken in a quiet place and the body relax. 

It is recommended to still 4~5 minutes before measurement. 

Do not talk and movement during the measurement. Relax the body, do not let the muscle activity. 

Do not use precision instrument near the Sphygmomanometer. 

4.3  Operation prompts 

1. take an automatic measurement 

The automatic measurement mode is used after the device is started. The default measurement 
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interval is 30min during the day and 60min during the night. 

The device is connected to the upper device through USB cable. After selecting the sampling 

scheme, the patient information and measurement interval can be configured. 

2. stop the automatic measurement 

Pressing the  button at any time during the automatic measurement process will stop the 

measurement. 

3. To start a manual measuring: 

◼ During the idle period of auto measuring process, press button at any time to start a 

manual measurement. Then press button to stop manual measurement and the 

system continues executing auto-measuring program. 

 Note  

If you are in doubt about the accuracy of any reading(s), check the patient's vital signs by an 

alternative method before checking the functioning of the monitor. 

 Warning  

If liquid is inadvertently splashed on the equipment or its accessories, or may enter the conduit 
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or inside the monitor, contact local Customer Service Center. 

Measurement Limitations 

The oscillometry method has some limitations depending on the patient's condition. This measure is 

based on the regular pulse wave generated by arterial pressure. In the case where the patient 

condition makes such a detection method difficult, the measured value becomes unreliable and the 

measuring time increases. The user should be aware that the following conditions will make the 

measurement unreliable or measurement time extended. In this case, the patient's condition will 

make the measurement impossible: 

⚫ Patient Movement 

Measurements will be unreliable or can not perform if the patient is moving, shivering or having 

convulsions. These motions may interfere with the detection of the arterial pressure pulses. In 

addition, the measurement time will be prolonged. 

⚫ Cardiac Arrhythmia's 

Measurements will be unreliable and may not be possible if the patient's cardiac arrhythmia has 

caused an irregular heartbeat. The measuring time thus will be prolonged. 

⚫ Heart-lung Machine 

Measurements will not be possible if the patient is connected to a heart-lung machine. 

⚫ Pressure Changes 
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Measurements will be unreliable and may not be possible if the patient's blood pressure is changing 

rapidly over the period of time during which the arterial pressure pulses are being analyzed to obtain 

the measurement. 

⚫ Severe Shock 

If the patient is in severe shock or hypothermia, measurements will be unreliable since reduced 

blood flow to the peripheries will cause reduced pulsation of the arteries. 

⚫ Heart Rate Extremes 

Measurements can not be made at a heart rate of less than 40 bpm and greater than 240 bpm. 

⚫ Obesity patient 

The thick fat layer of body will reduce the measurement accuracy, because the fat that come from 

the shock of arteries can not access the cuffs due to the damping. 

The following conditions may also cause changes in the blood pressure measurement value 

⚫ After eating (within 1h), or having drinks containing alcohol or caffeine, or after smoking, 

taking exercises or bathing; 

⚫ Using incorrect posture such as standing or lying down, etc.; 

⚫ The patient speaks or moves his body during measurement; 

⚫ When measuring, the patient is nervous, excited, or in unstable emotion; 

⚫ The room temperature rise or fall sharply, or the environment of measurement often changes; 
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⚫ Measuring in a moving vehicle; 

⚫ The position of cuff applied (higher or lower than the heart level); 

⚫ Continuous measurement for a long time; 

4.4  NIBP Error Messages and Solutions 

Display message Cause Solution 

Low battery Device battery is low. 
Replace the battery. If the problem 

still exists, please contact us. 

Loose cuff Cuff is not connected correctly. 
Reconnect the cuff. If the problem 

still exists, please contact us. 

Atmospheric 

pressure error 
Valve can not be open. 

Restart the device. If the problem still 

exists, please contact us. 

Signal is too 

weak 

Object measuring the pulse is too 

weak or the cuff is loose. 

Check the cuff connection, tighten 

the cuff if it is loose. 

It is over the 

range 

Object measuring blood pressure is 

over the measurement range. 

Take another measurement. If the 

problem still exists, please contact us. 

Excessive 

movement 

Movement may result in too much 

interference in the signal during 

Be sure to keep still during 

measuring process. 
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measuring process. 

Overpressure 
Cuff pressure is over the scope, 

ADU 300 mmHg. 

Check the cuff to make sure it is not 

blocked or squeezed. 

Saturated signal  
Movement or other factors may 

lead to too big signal amplitude. 

Check the connection of air tube to 

make sure it is not squeezed. Patient 

should keep quiet and then take a 

new measurement. 

Air leakage 
Possible air leakage in the valve or 

airway 
Check the air tube and the cuff. 

System failure 
Possible failure caused by pump, 

air valve or pressure sensor. 
Please contact us. 

It spends too 

much time 

The time for a single measurement 

exceeds the maximum 

measurement time (adult: 180s). 

Check the connection of air tube and 

tighten the cuff. 

4.5  Maintenance and Cleaning 

*Please do obey the precautions and correct operating methods in this user manual. Otherwise, 

we will not responsible for any fault. 
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 Warning  
◼ Remove the batteries before cleaning the device or peripheral equipment. The accessories and 

main unit must be separated for cleaning. 

◼ Do not squeeze the rubber tube on the cuff. 

Cleaning: 

◼ Do not soak the device and accessories in liquid. 

◼ If any damage or deterioration of the device and accessories is found, please do not use it. 

◼ Do not allow water or cleaning solution to flow inside the device to prevent damage to it. 

Maintenance: 

◼ Clean the device and accessories regularly. It is recommended to clean them every one month. 

When it gets dirty, use a dry and soft cloth to wipe. If the device, accessory or the peripheral 

equipment is very dirty, it is available to dip the soft cloth into water or mild detergent, and wring 

out, then use the cloth for cleaning. Do not clean the inner parts. 

◼ The device should be inspected and calibrated periodically or obey the requirements of the 

hospital(the recommended period is 1 year). It is available to inspect in the state specified inspection 

institution or by professional personal. Please contact our company's after-sales personnel if you 

need to enter the static pressure detection mode for inspection. 
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Storage: 

Advice  

Do not expose the device in direct sunlight for long time, otherwise the display screen maybe 

damaged. 

The basic performance and safety of the device are not affected by the dust or cotton wool in home 

environment, while the device shall not be placed where with high temperature, humidity, dusty or 

corrosive gases. 

Aged cuff may result in inaccurate measurement, please replace the cuff periodically according to 

the user manual. 

To avoid device damage, keep the device out the reach of children and pets. 

Avoid the device close to extreme high temperature such as fireplace, otherwise the device 

performance may be affected. 

Do not store the device with chemical medicine or corrosive gas. 

Do not place the device where there is water. 

Do not place the device where with slope, vibration or impact 

4.6  Transportation and Storage 

⚫ The packaged device can be transport by general vehicle or according to the order contract. 
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Do not transport the device mixed with toxic, harmful or corrosive materials. 

⚫ The device after packaged should be stored in a well ventilated room without any corrosive 

gas, temperature range: -20℃~+45℃, relative humidity no more than 95%. 

⚫ The permissible environmental conditions of transport and storage of the equipment after the 

equipment has been removed from its protective packaging and subsequently between uses is : 

temperature range: -20℃~+45℃, relative humidity no more than 95%. 

4.7  Key and Symbols 

Your device may not contain all the following symbols. 

Signal Description Signal Description 

 

Attention! Please refer to the 

accompanying document (the user 

manual). 
 

Attention! Please refer to the 

accompanying document (the user 

manual). 

SYS Systolic pressure DIA Diastolic pressure 

MAP Mean blood pressure PR Pulse rate (bpm) 

SN Serial number   EMC Electromagnetic compatibility 
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IPXX 
The degree of protection against 

ingress of water 
P/N Material code of manufacturer 

ADU Adult INFO Information 

ABPM Ambulatory Blood Pressure Monitor  

Type BF defibrillator proofed applied 

parts 

 Class II equipment 
 

Open the prompt sound indication 

 Batch code 
 

Use by date 

 
This way up 

 
Fragile, handle with care 

 
Keep dry 

 

Storage atmospheric pressure 

limitation 

 
Storage temperature limitation 

 
Storage humidity limitation 
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Manufacturer 

 
Date of manufacture 

 Batteries Power   Pulse rate (bpm) 

 

Waste disposal mark, this symbol 

indicates that the waste of electrical 

and electronic equipment can not be 

disposed as an unclassified municipal 

waste and must be recovered 

separately. 

 

This item is compliant with Medical 

Device Directive 93/42/EEC of June 

14, 1993,a directive of the European 

Economic Community. 

 
 Recyclable  European Representative 

  Free of natural rubber latex   
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Chapter5  Requirements of Hardware 

Processor: Basic frequency 2.5G or more 

Operation System:Windows XP or higher 

EMS memory: 1GB and more 

Hard Disk: 250G or more 

Display:Resolution ratio 1024*768 or higher 

USB: 2 or more 

Resolution of printer: 600 DPI 



 

copy for trendmedic.com  - 2024  37 

Chapter6  Software Functions 

6.1 Registration 

Double click the software icon, a dialogue box for entering user account pops up: 

 

 

Figure 6.1 Registration 

Please input your name, then click "Okay" to enter the main interface. Click "Delete", you can delete 

one registered user information, click "Delete all", you can delete all the registered user information. 
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6.2 Main interface 

After finishing the registration, enter the main interface as shown below: 

 

Figure 6.2 Main Operating Interface 

1. Menu: The main operating menu of this software 

2. Toolbar: Shortcut keys for functions of frequent use 

3. The middle area is used to display graphs. After choosing the case to be edited, the data analysis 

graph, including trend graph, histogram, pie chart and fit line will be displayed here. 
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6.3 Collection scheme setup 

Click the shortcut key or in the menu, a dialogue box "Upload Parameters" will 

appear: 

 

Figure 6.3.1 Setting of Collection Parameters 
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As shown above, doctors could set the parameter according to patient’s condition and the need of 

diagnosis. The monitor is able to finish the collecting task as your settings. Specific parameters are 

explained as follows: 

Patient Name: name of the patient 

Patient ID: It is an unique number used to identify the patient. The purpose is to prevent the 

occurrence of the same name patients. 

Manual measure: to support manual collecting, which means the measurement can be achieved by 

pressing the button on the device. 

One key lock: to lock or not lock the menu function 

Beep main switch: to turn on/off the master switch of prompt sound 

Awake Beep Switch: to turn on/off the prompt sound when the patient is in non-sleep state, the 

prompt range is determined by the four parameters below 

Asleep Beep Switch: to turn on/off the prompt sound when the patient is in sleep state, the prompt 

range is determined by the four parameters below. 

Current Time: current system time. 

Settings of parameters in time period: 

Day: non-sleep condition of the patient; 

Night: sleep condition;  
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Special Start and Special End are optional items. You can set the data collection for special time 

periods.  

Interval refers to the time interval of collection. To minimize the impact of sleep patients, generally 

collection interval during sleep condition is set to be longer. 

Take the above picture as an example: the range of awake time in the day is 7:00-22:00, the range of 

asleep time in the night is 22:00-7:00 (next day), the interval of the awake time is 30 minutes, and 

the interval of the asleep time is 60 minutes. 

The range of daytime duration, nighttime duration and special testing duration are displayed in 

graphic form on the screen, which facilitates the parameter setting. 

After setting the parameter, click "Okay" to upload the scheme. If the parameter is set correctly, and 

the monitor and computer are connected well, the data will start uploading. Uploading progress is 

shown as below: 

 

Figure 6.3.2 Uploading Progress Bar 



 

copy for trendmedic.com  - 2024  42 

6.4 Download 

Before downloading, please make sure that: 

The device has been connected to PC correctly; 

The device is in power-on state; 

The device is not connected to the patient when connecting with the PC. 

Click the shortcut key , or select "Download"→"Do Download" in the menu, after 

identifying the device, an interface for editing patient information appears on the software, in which 

you can edit the basic information of patients. After downloading a case, the patient information will 

be saved in the case file. The patient information editing interface is shown as below: 
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Figure 6.4.1 Patient information 
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Click "Okay" to start downloading the data, the process bar is shown as below: 

 

Figure 6.4.2 Downing Progress Bar 

6.5 Path of case file 

User can choose the storage path of case files, select "System" in the menu, then select "Set 

File Path", the interface is shown as below: 
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Figure 6.5 Case file path 

6.6 Case select 

Before editing, choose a case file first. Click the shortcut key  or select "File" → "Open data" 
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in the menu to enter case selection interface as shown below: 

 
Figure 6.6 Case Selection 

In the interface, you are able to select the file folder for data storage, if there are files in the folder, 

all the file information will be listed, including: patient name, patient ID, start time and file name. 

Choose the file you want to edit, then click "Okay". 
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6.7 Delete 

If some cases are not necessary any more, you can delete them. Select "File" → "Delete data" in the 

menu, the deleting interface will appear, which is similar to case selection interface, shown as 

below:  

 

Figure 6.7 Select a Case for Deleting 

You are able to delete one single file or multiple files at the same time; to delete multiple files, you 

need to press "Ctrl" on the keyboard and select the files you want to delete, after that, click "Okey", 
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an alert dialogue box will pop up, then click "Okay" to delete. If you want to cancel, please click 

"Cancel". 

6.8 Backup 

Sometimes, you may want to save one original copy before you edit a file, then you need to backup 

the case file. The software provides such function. Select "File" → "Copy data" in the menu to open 

the data backup interface, as shown below: 

 

Figure 6.8.1 Select a Case to Backup 
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After selecting the file, click "Okay", a dialog box of file path setting appears, as shown below, in 

which you can set the path of backup file, after that, click "Okay" to save. 

 

Figure 6.8.2 Backup Path Setting 
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6.9 Blood Pressure Data 

You can edit each data record. Click the shortcut key or choose "Edit" → "BP data" in the 

menu, the data editing interface as shown below will be displayed: 

 

Figure 6.9 Data Editing Interface 
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In this interface, you can view the details for each data. In which, 

*=5/192(2.6%): 192 stands for data sum, 5 stands for the number of deleted data, 2.6% stands for 

the present of deleted data. 

Number: the serial number of data collecting. 

Time: collecting time. 

Date: collecting date. 

Sys (mmHg): the high blood pressure value, its unit is mmHg; 

Dia (mmHg): the low blood pressure value, it unit is mmHg; 

PR (bpm): value of pulse rate, unit is bpm. 

MAP (mmHg): the average pressure value of high blood pressure and low blood pressure, unit is 

mmHg. 

PP (mmHg): pressure difference between high and low blood pressure, unit is mmHg. 

Position: displays the posture status if this function is available 

TC: error code 

Comment: notes for the data. 

These data can be edited. ‘*’ means that the data is deleted (it will not displayed in trend graph or in 

the record statistic). You can delete/add the ‘*’ by clicking the left mouse button in its area. Also, in 
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the comment column, you can add notes for the data, and these information will be shown in the 

trend graph. 

By clicking buttons, you can display all data or hourly average value, or display by hour. 

6.10 Trend Graph 

After selecting a case, its trend graph will be shown on the computer automatically. In other 

interfaces, clicking the shortcut key  could enter its interface. There are two types of trend 

graphs: trend for color filler style and trend for dotted line style. The trend shows as follows: 
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Figure 6.10.1 Color Filler Style  
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Figure 6.10.2 Dotted Line Style 

Click the "Graph type" to switch between the two different trend graphs. When the cursor moves to 

the displaying area, data information that the mouse pointing will be shown on the top of the screen, 

including number, time, date, high/low BP value, PR, comment, etc. You can click the left mouse 

button to delete/add necessary data point. If the distance between the two data points is too short and 

the cursor cannot be moved to one of the points, move the cursor to the x-axis, press the left mouse 

button and drag the mouse to right, then the trend graph will be shown in a stretching form; and if 



 

copy for trendmedic.com  - 2024  55 

drag the mouse to left, the trend graph will be shown in a shrinking form. When the trend graph is 

stretched, you can control the movement of trend graph by scrollbar if it exceeds the displaying area, 

until you could observe the data you wanted. Similarly, you can also move the cursor to the y-axis, 

press the left mouse button and drag the mouse up/down to achieve stretching/shrinking display. 

 

Figure 6.10.3 Trend Graph Shrink (x-axis) 
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Figure 6.10.4 Trend Graph Stretch (x-axis) 
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Figure 6.10.5 Trend Graph Stretch (y-axis) 
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Figure 6.10.6 Trend Graph Shrink (y-axis) 
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6.11 Statistics information  

Click the shortcut key , or choose "Edit"→"View statistics" in the menu, a dialog box for data 

statistic information will pop up, as follows: 

 

Figure 6.11 BP Statistics Information 

The upper half of above figure shows the average value of the data. The lower half shows the 

percentage of data that exceeds the alarm limit. And the data 135/85, 120/70, 130/80 respectively 
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represents the limit value of high/low pressure in the awake/ sleep/ whole day condition. The unit is 

mmHg. 

6.12 Diagnostic information 

Click shortcut key , or select "Report"→"Diagnose" in the menu, as shown below: 

 

Figure 6.12.1 Diagnosis information 
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Click "Auto con" button, the software will automatically analyze the current case and display 

the diagnosis conclusion. The conclusion has several items, which can be set by user. Click "Report 

settings" to select "Analyze item", a dialogue box for choosing analysis items pops up, shown as 

below: 

 

Figure 6.12.2 Analysis items 
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Also, you can choose to edit the diagnosis conclusion by your own, and edit, delete, add, and 

update the analysis items. 

6.13 Sleep period setup 

Setup of sleep period includes: day time and night time. This is necessary because the patient 

may not sleep or wake up at the exact time set in the collection scheme when patient data is being 

collected. After setup, the software will recalculate the data, and update trend graph and recalculate 

the statistic information automatically. Select "System"→"Sleep Times" in the menu, a dialogue box 

shown as below will appear: 

 

Figure 6.13 Sleep period Setting 
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6.14 Alarm limit setup 

The alarm limit of blood pressure can be set, after that, the trend graph will update 

automatically, and the statistic data will be recalculated. Select "System"→"Threshold" in the menu, 

a dialogue box of BP alarm limit will pop up, as shown below: 

 
Figure 6.14 BP Alarm Limit Setting 



 

copy for trendmedic.com  - 2024  64 

In the day time, the default alarm limit of high/low blood pressure is 135mmHg/85mmHg; in 

the night time, the default alarm limit of high/low blood pressure is 120mmHg/70mmHg; in a whole 

day, the default alarm limit of high/low blood pressure is 130mmHg/ 80mmHg. 

Besides, the setting includes the followings: 

The normal range of "Day BP load value", default setting is less than 20%; 

The normal range of "Night BP load value", default setting is less than 25%; 

The normal range of "Circadian rhythm of BP ranges", default setting is 10%~20% 

The AASI is less than 0.55 in normal condition. 

The MBPS larger than 35mmHg indicates blood pressure elevation. 

6.15 Histogram 

Click the shortcut key , a histogram analyzing blood pressure and pulse rate will show 

up, as following: 
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Figure 6.15 Histogram 

The three values (SYS, DIA, PR) can be displayed for each time period by selecting "All", "Day" 

and "Night" on the right side. 

6.16 Pie Chart 

Click the shortcut key , a pie chart analyzing blood pressure and pulse rate will show up, as 
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following: 

 

Figure 6.16 Pie Chart 

Pie chart interface is divided into four parts. The first part displays the maximum/ minimum/ 

average value for the measured data; the second part is the pie charts; the third part provides 

corresponding settings for the pie charts on the left; the fourth part has three options of "All", "Day", 

"Night", the analysis of values for each time period can be shown individually. 
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6.17 Fitting line 

Click the shortcut key , the fitting line of blood pressure data will appear, as shown below: 

 

Figure 6.17 Fitting Line 
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Red represents systolic blood pressure; blue represents diastolic blood pressure. The empty circle is 

the blood pressure value measured during the day and the filled circle is the blood pressure value 

measured at night. 

Histogram, pie charts and fitting line help to observe the data. 

6.18 Report print 

The software supports printing in A4/B5 paper. If you want to print a report, first select "Start" 

→ "Printers and Faxes" → "default printer driver icon" in the system, click the right mouse button, 

choose "Properties" → "Printing Preferences" → "Paper", select A4/B5 as the paper size. Then open 

the software, click "Report" → "Select Printer", the printer selection interface will pop up. In this 

interface, you can select the printer you are connected to, as well as the default paper size for 

printing. If the default paper size of printer is A4 (B5), the software will print according to A4 (B5) 

size. 

When you finish the editing of blood pressure data, patient diagnostic information, etc., the 

software will generate a series of analysis reports. You can choose all reports or several of them for 

printing. 
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Select "System" → "Configurate Report" in the menu, the following dialog box will pop up: 

 

Figure 6.18.1 Report Configuration 

Click the shortcut key , or select "Report"->"Report" in the menu, it will directly go to 

the print preview interface. Operator could see the printing result of the page that just selected. Print 



 

copy for trendmedic.com  - 2024  70 

preview interface as follows: 

 

Figure 6.18.2 Print Preview 

Make sure that there are no mistakes in the report, click  on the top left corner of the 

interface, the attribute interface of printer will pop up, then click the "Okay" button, print job will be 
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sent to the printer for printing. 

6.19 Help 

Click "Help"-> "Help Document" in the menu to pop up the help information, which gives a 

brief description of each function, and facilitates you to quickly know how to use the software. 
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 Specification 

Name Ambulatory Blood Pressure Monitor 

The degree of 

protection against 

ingress of water 

IP22 

Display 1.3'' color LCD Display 

Operating mode Continuous operating 

NIBP Specifications 

Measurement Method Oscillometric method 

Working modes Automatic 

Cuff pressure range 0~300 mmHg(0~40 kPa) 

Blood pressure 

measurement Range 

SYS：30～270 mmHg(5.3~36.0 kPa) 

DIA：10～220 mmHg(1.3~29.3 kPa) 

Pulse measurement 

range 
40~240/min 

Inflation 160mmHg(21.33 kPa) 
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Resolution 

Pressure 1 mmHg（0.133 kPa） 

Measurement Accuracy 

Cuff Pressure 

Accuracy 

Static pressure: ±3 mmHg(±0.4 kPa) 

Error 

The BP value measured by the device is equivalent with the 

measurement value of Stethoscopy, perform clinical verification in 

accordance with the requirements in ISO 81060-2: 2013, whose 

error meets the followings: 

Maximum mean error: ±5 mmHg 

Maximum Standard deviation: 8 mmHg 

Operating 

temperature/ 

humidity 

 +5 ºC~40 ºC        15 %RH~85 %RH(Non-condensing) 

Transport 

Transport by general vehicle or according to the order contract, 

avoid pounded, shake and splash by rain and snow in 

transportation. 
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Storage 
Temperature: -20 ºC~+55 ºC; Relative humidity: ≤95 %; No 

corrosive gas and drafty. 

Atmospheric pressure 700 hPa~1060 hPa 

Power Supply DC 3.7 V  lithium battery 

Battery service life 

Under the condition of room temperature 23℃, arm circumference 

270mm and measuring normal blood pressure value, a fully 

charged lithium battery can support 100 times measurements or 

more. 

Rated Power 10 VA 

Dimensions 118(L)*63(W)*27 mm(H)   

Unit Weight 260 gram(with batteries) 

Safety classification 
Internally powered equipment 

Type BF defibrillation-proof applied par 

Service life The service life of the device is five years of BP measurement. 

Date of manufacturer See the label 
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Appendix 

Guidance and manufacturer's declaration – electromagnetic emissions- 

for all EQUIPMENT and SYSTEMS  

Guidance and manufacturer's declaration – electromagnetic emission 

The device is intended for use in the electromagnetic environment specified below. The customer 

of the user of the device should assure that it is used in such and environment. 

Emission test Compliance Electromagnetic environment – guidance 

RF emissions 

CISPR 11 
Group 1 

The device uses RF energy only for its internal 

function. Therefore, its RF emissions are very 

low and are not likely to cause any interference 

in nearby electronic equipment. 

RF emission 

CISPR 11 
Class B 

The device is suitable for use in all 

establishments other than domestic and those 

directly connected to a low voltage power 

supply network which supplies buildings used 

for domestic purposes. 
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Guidance and manufacturer's declaration – electromagnetic immunity – 

for all EQUIPMENT and SYSTEMS 

Guidance and manufacturer's declaration – electromagnetic immunity 

The device is intended for use in the electromagnetic environment specified below. The 

customer or the user of device should assure that it is used in such an environment. 

Immunity test 
IEC60601 test 

level 

Compliance 

level 

Electromagnetic 

environment - guidance 

 

 

Electrostatic 

discharge (ESD) 

IEC61000-4-2 

 

 

 

6 kV contact 

8 kV air 

 

 

 

6 kV contact 

8 kV air 

Floors should be wood, 

concrete or ceramic tile. If 

floor are covered with 

synthetic material, the 

relative humidity should be 

at least 30%. 

Power frequency 

(50/60Hz) 

magnetic field 

IEC61000-4-8 

 

3A/m 

 

3A/m 

Mains power quality should 

be that of a typical 

commercial or hospital 

environment. 

NOTE: UT is the a.c. mains voltage prior to application of the test level. 
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Guidance and manufacturer's declaration – electromagnetic immunity – 

for EQUIPMENT and SYSTEMS that are not LIFE-SUPPORTING 

Guidance and manufacturer's declaration – electromagnetic immunity 

The device is intended for use in the electromagnetic environment specified below. The 

customer or the user of device should assure that it is used in such an environment. 

Immunit

y test 

IEC60601 

test level 

Compliance 

level 
Electromagnetic environment - guidance 

 

 

 

 

 

 

 

 

 

Radiated 

RF 

 

 

 

 

 

 

 

 

 

3 V/m 

80 MHz to 

 

 

 

 

 

 

 

 

 

 

3 V/m 

Portable and mobile RF communications 

equipment should be used no closer to any part 

of the device, including cables, than the 

recommended separation distance calculated 

from the equation applicable to the frequency of 

the transmitter. 

Recommended separation distance 

P
E

d 







=

1

5.3

   80 MHz to 800 MHz 
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IEC 

61000-4-

3 

 

 

2.5 GHz 

 P
E

d 







=

1

7

     800 MHz to 2.5 GHz 

Where P is the maximum output power rating of 

the transmitter in watts (W) according to the 

transmitter manufacturer and d is the 

recommended separation distance in metres (m). 

Field strengths from fixed RF transmitters, as 

determined by an electromagnetic site survey, a 

should be less than the compliance level in each 

frequency range.b 

Interference may occur in the vicinity of 

equipment marked  

with the following symbol: 

 

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is 
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affected by absorption and reflection from structures, objects and people. 

a Field strengths from fixed transmitters, such as base stations for radio 

(cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio 

broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the 

electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey 

should be considered. If the measured field strength in the location in which the device is 

used exceeds the applicable RF compliance level above, the device should be observed to 

verify normal operation. If abnormal performance is observed, additional measures may be 

necessary, such as reorienting or relocating the device. 

Recommended separation distances between portable and mobile 

 RF communications equipment and the EQUIPMENT or SYSTEM –  

for EQUIPMENT or SYSTEM that are not LIFE-SUPPORTING 

Recommended separation distances between  

portable and mobile RF communications equipment and the device 

The device is intended for use in an electromagnetic environment in which radiated RF 

disturbances are controlled. The customer or the user of the device can help prevent 

electromagnetic interference by maintaining a minimum distance between portable and 

mobile RF communications equipment (transmitters) and the device as recommended below, 
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according to the maximum output power of the communications equipment. 

Rated maximum 

output power of 

transmitter (W) 

Separation distance according to frequency of transmitter (m) 

80 MHz to 800 MHz 

 

800 MHz to 2.5 GHz 

 

0.01 0.12 0.23 

0.1 0.37 0.74 

1 1.17 2.33 

10 3.69 7.38 

100 11.67 23.33 

For transmitters rated at a maximum output power not listed above, the recommended 

separation distance d in metres (m) can be estimated using the equation applicable to the 

frequency of the transmitter, where P is the maximum output power rating of the transmitter 

in watts (W) according to the transmitter manufacturer. 

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range 

applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is 

affected by absorption and reflection from structures, objects and people. 
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Warning  

●Active medical devices are subject to special EMC precautions and they must be installed and used 

in accordance with these guidelines. 

●Electromagnetic fields can affect the performance of the device, so other equipment used near the 

equipment must meet the appropriate EMC requirements. Mobile phones, X-rays, or MRI devices 

are possible interference sources, as they emit high-intensity electromagnetic radiation. 

●The use of ACCESSORIES, transducers and cables other than those specified, with the exception 

of transducers and cables sold by the MANUFACTURER of the the device as replacement parts for 

internal components, may result in increased EMISSIONS or decreased IMMUNITY of the ME 

EQUIPMENT or ME SYSTEM. 

●The device should not be used when they are close to or stacked with other equipment, if necessary, 

please observe and verify that they can operate normally in the configurations. 

●Devices or systems may still be interfered by other equipment, even if other equipment meets the 

requirements of the corresponding national standard. 

●The device requires special precautions for electromagnetic compatibility (EMC) and requires 

qualified personnel to install and use in accordance with the EMC information provided below. 

●The device should not contact the pins of connectors marked with an ESD warning symbol, unless 

electrostatic discharge precautions are used, the device should not connect to these connectors. 
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●In order to avoid the accumulation of electrostatic charge, it is recommended to store, maintain and 

use the equipment at a relative humidity of 30% or more. The floor should be covered with ESD 

dissipated carpets or similar materials. In the use of the components, non-synthetic clothing should 

be wore. 

●In order to prevent electrostatic discharging to the ESD-sensitive parts of the device, the personnel 

should contact the metal frame of the components or the large metal objects near the device. When 

using the device, especially when it is possible to contact the ESD-sensitive parts of the device, the 

operator should wear a grounded bracelet designed for ESD-sensitive devices. For more information 

on proper use, please refer to the instructions provided with the bracelet. 

●All potential users are advised to understand the ESD warning symbols and receive training on 

ESD precautions. 

●The most basic content of the ESD precautionary procedure training should include an introduction 

to electrostatic charge physics, voltage level in the conventional case, and damage to the electronic 

components when the operator with electrostatic charge contacts them. In addition, the methods for 

preventing electrostatic buildup, and the manner and reasons for the release of human body static 

electricity to the ground or equipment frame or the use of a bracelet to connect the human body to 

the equipment or the ground before establishing the connection should be described. 

 

 



 

  

 


